
Rockford! 3.0
INTRODUCTION

Need a business card? Rockford!'s your Windows solution. It lets you design and
print business cards to suit any purpose. You can use any Windows font, add clip
art images or lines, boxes, and circles, set text alignment any way you want, then
print your cards on any Windows-compatible printer. Rockford! even has custom 
settings for three types of pre-scored business card stock available from many 
dealers. Or you can print a 200% or four-up layout to take to your print shop. 
Print as few or as many cards as you need...in minutes.

LICENSE INFORMATION

Rockford! is a shareware program. You may use it for a trial period of up to 30 
days. After that time, you must register your copy of the program. The registration
fee is only $20. Registered users will receive the very latest version of the 
program, a printed manual, and are entitled to full support by phone, fax, mail, 
BBS and on CompuServe. When you register, all phone numbers and access 
information will be provided. Registered users are also entitled to unlimited free 
upgrade downloads on the OsoSoft BBS. Non BBS upgrades will incur a small 
charge. Non-registered users receive only a bare minimum of support, and 
are not entitled to telephone support at all. 

To register your copy, run the program. In the Help menu is an entry for OsoSoft 
Information. There, you can get information on all OsoSoft programs and fill out 
an order blank on screen. When you're done, click the [Print] button to print out a
copy, then mail it with your payment to the address on the form.

You can also register with a credit card by calling Public Software Library at 800-
242-4775 or 713-524-6394. NOTE: These numbers are for ORDERS ONLY! The
author of this program is not available at those numbers, and no information will 
be provided to callers. This is only an ordering service. A shipping and handling 
charge of  $4 is added to all credit card orders.

CompuServe users may also register on CompuServe. Just type GO SWREG at 
any system prompt, then find the program and register it. Charges are added to 
your CompuServe bill.

OSOSOFT BBS

Please feel free to call the OsoSoft BBS at any time. The number is (805) 528-
3753, and you may call at any baud rate from 300-14400. Set your parameters to
8 bits, No parity, and 1 stop bit. The latest shareware versions of OsoSoft 
programs are always online, along with clip art collections and a number of free 



programs from OsoSoft. If you have a modem, be sure to call!

ROCKFORD! PROFESSIONAL

A Professional Version of Rockford! is also available, only from the author. This 
version includes a large clip art library, plus special advertising lines on printouts 
to help you sell your business services. In addition, this version, offers customer 
approval lines at the bottom of each layout. If you use Rockford! in your 
business, you should buy this copy. The price is just $30.

SYSTEM REQUIREMENTS

Rockford! requires a 386/486 CPU, Windows 3.1, a hard disk and mouse, plus a 
minimum of 2 MB of RAM and 2 MB of hard disk space, VGA or better graphics 
and a Windows-compatible graphics printer  You'll also need about 6 MB of free 
disk space on the disk where you store .TMP files for Temporary files. This 
program supports only TrueType and Adobe Type Manager fonts.

FEATURES

WYSIWYG Design Screen
Horizontal and Vertical Card Designs
Line, Box, and Circle Drawing 
Four Border Types
Adjustable Margins & Border Offsets
Split Lines of Type
Create Bulleted Lists
Insert Two BMP or PCX Clip Art images on Card
Preview Clip Art Before Loading
Scale and Position Pictures—.01" Accuracy
Insert Character Formats inside Lines
Print Card Layouts, with 200%-sized camera-ready copy
Print Sheets of Ready-to-cut Cards (9 or 10 cards per sheet)
Save Completed Cards to Disk.
Customize Printouts with Your Business Name
.005" Positioning and Scaling Accuracy
Clip Art Library
Text Reverses for flexibility

INSTALLATION

To install Rockford!, first create a directory especially for the program (E.G.: C:\
ROCKFORD) from the DOS prompt or with the Windows File Manger. If you 
need help with the DOS MKDIR (MD) command, see your DOS manual. Don't be
tempted to copy the Rockford! files into your main WINDOWS directory. There 
are far too many files, and you'd only cause yourself confusion.



Now, copy all the files on all disks included with Rockford! into your new 
directory. You can use the DOS command line, the Windows File Manager, or 
another Windows shell program to do this. Finally, copy the VBRUN200.DLL, 
CSPICTUR.VBX, QPRO200.DLL, and PPORIENT.DLL files from  the distribution
disk into your WINDOWS\SYSTEM directory. You can then delete those four files
from your Rockford! directory. 

Next, start up the Windows Program Manager, if it's not already on the screen. If 
you use another program shell, such as Norton Desktop for Windows, you'll need
to consult that program's instructions on manually installing a new program. 
Otherwise, with Program Manager, follow the instructions below:

1. Click on the program group you want to contain the Rockford!  icon.
2. Click the Program Manager's File menu command.Click the New command.
3. Click [OK] in the next dialog box to create a new program item.
4. In the Description field, type Rockford!, then press the <Tab> key.
5. In the Command Line field, type the Path to your Rockford! directory, then 
type ROCKPRO.EXE in the dialog box field. Your entry should look like this:

C:\ROCKFORD\ROCKPRO.EXE

6. Press <Tab>, then enter the same path in the Working Directory field, with no
backslash. Your entry should look like this:

C:\ROCKFORD

7. Check your information, then click OK.
8. The Rockford! icon will appear in the program group box you selected. You 
may have to use the scroll bars to find it, but you can then drag the icon to a new 
location. 

THE ROCKFORD!  INTERFACE

If this is the first time you've used Rockford!, be sure to read this entire manual. It
contains important information on using the program. Become familiar with all the
menus, buttons, and techniques supplied here. If you try to go it on your own, 
you're likely to run into problems, since business card design isn't  always 
completely  intuitive. While the program does a simple task, it's a complex job, as
you'll see if you try to create business cards in a word processor or other 
program. Pay special attention to the Tutorial and Tips sections of the manual. If
you're using pre-cut paper stock, be sure to read that section especially carefully.

To run Rockford!, start Windows, then double click on the Rockford! icon in the 
Program Manager. When you start Rockford!, you'll have a short delay while the 
program creates its font list and prepares the rest of the program. A notice will 



appear on your screen as the program loads. If you have a large font library, this 
may take up to a minute. On subsequent program loading, the program will load 
the font list from its own file. If you add or delete fonts, Rockford! Pro will prompt 
you to refresh your font list. 

Next, you'll see the Rockford! main screen. Unlike many other Windows 
programs, Rockford! uses command buttons and drop-down list boxes, rather 
than menus, to perform most functions. The commands you need to create card 
designs are always right on the screen, grouped according to function. Traditional
Windows menus offer some less-used commands. A combination of menu and 
on-screen commands will take you through card design in just minutes.

EDITING AND DISPLAY BOXES

You'll see two boxes on the screen. At the top is the text-editing box. Here, you'll 
enter and edit all the text to be included on your card. Just below it is another 
box, where a WYSIWYG display of your card appears. You can't edit directly in 
this WYSIWYG box.

Editing Text in Rockford! Pro
Rockford!'s editing box works much like your Windows word processing program.
You can simply type your text in the box. To position the cursor in your text, either
use the cursor keys or click the mouse cursor where you want to type. If you 
select text by dragging with the mouse, new text you type replaces the selected 
text.

If you have the auto-update feature on, the WYSIWYG display updates when the 
cursor moves from one line of text to another. You'll find it much faster to 
reposition the cursor with the mouse in most cases. Use the mouse whenever 
you're moving the cursor more than one line.

When you're entering text, all attributes continue from line to line when you press 
the <Enter> key. You are limited to 20 lines of text in Rockford!.

LEFT SIDE COMMAND BUTTONS
On the far left of your screen is a vertical row of buttons, in three groups. These 
buttons handle basic file and printing operations.

The Text Group
[Edit]—This button returns the cursor to the text editing box. Since Rockford! 
normally returns control to this box, you'll rarely have to click this button.

[Exit]—Click this button to leave Rockford!. You'll be asked to confirm this 
choice.

The Card Group



[Update]—This button updates the WYSIWYG display. To prevent excessive 
delays, some commands used in Rockford! do not automatically update this 
display.

[Clear]—This button clears your current card from the screen and from memory. 
You'll be asked to confirm this command in a dialog box. 

[New]—This button clears your current card and prepares Rockford! for an 
entirely new card, with no filename attached.

[Load]—The Load command lets you retrieve an existing card design from your 
hard disk. You'll see a typical Windows file opening dialog box, listing the files 
available. Normally, your card designs will have the file extension .CAR, unless 
you specify a different extension. 

[Save]—Saves the current card with the current filename. No prompting takes 
place, and the design on the screen at the time of the save overwrites any 
previous data. 

[Save As]—Lets you assign a new name for a card design. If you're creating 
several variations of the same card, be sure to use this command to prevent 
overwriting a previous design. If you enter a filename without an extension, 
Rockford! will use .CAR. 

[Print]—This button drops the file menu down, highlighting one of the available 
printing options. Click the mouse on the one you want to use. Remember, you 
now have the option of printing four-up layouts, which are preferred by many print
shops.

The Layout Group
[Grid]—This button overlays a grid on the WYSIWYG display, to help you in 
positioning text and graphics. The grid has divisions of .1-inch, with full inch lines 
in bold. The grid disappears when you press this button again. Use this feature 
with clip art and when using custom alignment for text.

[Horiz]—This button selects a Horizontal card layout. This is the default, and 
appears when you start Rockford!. If you change from a Vertical layout, you'll be 
prompted to clear your current card.

[Vert]—This button switches to a Vertical layout. This command clears the card, 
after allowing you to confirm or cancel. (Not available with pre-cut card stock)

[Margins]—This button lets you set customized margins for your card. These 
margins affect only the top and sides, and do not alter the position of any 
borders. The default is .1 inch. If an offset has been set, that offset is added to 
the margin automatically. NOTE: This margin affects only the left and top 



margins. You're responsible for the bottom and right margins, so keep an eye on 
your design and make whatever changes are needed in alignment, etc. to keep 
all elements from straying off the edge of the card.

[Offset]—This button controls the spacing between the card edge and the 
borders drawn with the Border Type list box. The default is 0. This command has 
no effect if the card design has no border.

RIGHT SIDE COMMANDS

On the right side of the editing and WYSIWYG windows are three other groups of
commands. These deal with text formatting and graphics. Some of these are 
buttons, while others present options in list boxes for easy selection. Starting 
from the top:

Text Attributes (Whole Line)
[Line]—Displays the current line number, as determined by the position of your 
cursor in the text editing box. You can also drop down a list box to select a line 
for processing. 

[Dupe Previous]—This button allows you to repeat the formatting of the line 
above the current line. This is useful whenever you want duplicate formats on 
several lines. Just format the first line to contain that format, then move to the 
next line and click this button. All line attributes will be duplicated. When typing, 
pressing <Enter> automatically copies the previous line's formatting.

[Font]—This drop-down list box displays the current font, and allows you to 
change a line to another font. Click on the arrow to drop down the font selection 
list. Scroll through the list, then click on your font selection. You'll see a sample of
your selected font. 

[Size]—Displays the current size for the font used on the current line. Click the 
arrow to drop down a list of available font sizes for the line. Sizes range from 4 to
36 points, in one-point intervals for the smaller fonts. HINT: Changing the font 
size of a blank line affects line spacing. Use this trick to adjust line spacing in 1-
point intervals.

[Border]—Another list box, this one offers five options for card borders, ranging 
from none, to single, double, bold, and thin/thick double lines. The current 
selection shows in the display area. To change, click the down arrow.

[Align]—This control affects the alignment of the selected line. The current 
setting shows in the display area. To change, click the arrow, then select your 
option. You can choose left or right aligned, centered, split lines, or set a 
customized horizontal and vertical position. HINT: When using customized line 
postions, apply these to lines at the bottom of the card's text to avoid later 



misalignments in normal lines.

NOTE: For split lines, insert a tilde (~) in the text box where you want the line to 
split. Rockford! will automatically separate the two halves of the line. You cannot 
insert internal formatting codes in split lines. Normally, lines are split with the left 
half aligned with the left margin and the right half aligned with the right margin. 
By inserting spaces before or after the text, you can create custom alignments, 
such as blocks of text centered on both sides. 

[Style]—Four check boxes control text attributes for the entire line. 

[Rev.]—this option prints the current line in white type on a black background. 
You cannot use this option on split lines or when using inserted formatting 
command. You can, however use any of the other text attributes with this feature.

The Clip Art Group
[AddArt]—Opens a dialog box for loading .BMP or .PCX clip art images. 
Rockford! Pro supports both black and white, or color images up to 256 colors. 
To see a preview of an image, click once on the filename. To load the image, 
double-click the file or click OK. Rockford! Pro will automatically select either the 
first or second clip art image, and position it in the WYSIWYG display. TIP: If your
desired clip art image appears far too large or small, edit it in a graphics program 
to make it approximately the correct size before importing it into your card. 
Drastic scaling usually produces poor images if done within Rockford!.

[Delete]—Deletes the currently-selected clip art image, as shown in the option 
buttons. Once you have deleted an image, you must load it again from the disk. 
NOTE: If you're loading a card created by an earlier version of Rockford!, your 
image will not appear on the card. First, select the PIC 1 option, then delete the 
image and reload it from disk.

[Option Buttons]—Select one of the two clip art images. You may select by 
clicking the button, or by double-clicking on the image itself. You must select an 
image before acting on it. Options are PIC 1 and PIC 2. Normally, PIC 1 is on the
left side of the card, and PIC 2 is on the right side of the card, although this may 
change if you move the image. When you select an image, a thin border will 
appear around the image.

[Sizing Scroll Bar]—Use this control to resize a clip art image, after selecting 
the desired image, as described above. For small changes, click the arrows. 
Click between the arrows for larger changes. Avoid moving the thumb.

MOVING A CLIP ART IMAGE
You can move a clip art image by dragging it around the screen with the mouse. 
To do this, first select the image you want to move by clicking the appropriate 
option button in the Clip Art Group, or by double-clicking on the image itself. 



When the image is selected, a thin border appears around the image. With the 
image selected, click the left mouse button somewhere outside of the image. 
The image will instantly move with its upper, left corner at the position where you 
clicked. Then, with the mouse button held down, you can drag the image to a 
new location. The new location is stored with the card when you save. If you try 
to drag the image by first clicking on the image, a message will appear telling you
to click outside the image. For precise positioning, try turning on the Grid display 
before positioning the image.

SCALING A CLIP ART IMAGE
To alter the size of a clip art image, select it as described above, using the option 
buttons or by double-clicking on the image. Then, use the scroll bar in the Clip Art
group of commands to change the size. For small changes, click the arrows on 
the scroll bar. For larger changes, click the blank space between the arrows. 
Avoid using the thumb to change image sizes, since it may alter the size of the 
surrounding box containing the image. You can scale images between 10% to 
500% of the original size.

Avoid major changes in clip art image size, to avoid image degradation. If you 
need to enlarge or reduce an image very much, do so in a paint program like 
Windows Paintbrush before loading it into Rockford!. This will result in an 
improved appearance on your card, since paint programs have sophisticated 
scaling routines.

Also, very large images scaled to fit a business card may create a temporary file 
when printed that is too large for your free disk space. Again, scale your images 
outside of the program. To help you with that, you can edit the currently selected 
image with the Edit Image command in the Edit menu. If you do this, after 
editing the image, delete the current image, then reload the new version from 
disk with the AddArt button.

The Graphics Objects Group
This group controls line drawing, plus positioning and scaling of both line drawing
objects and inserted clip art images.

[Object]—This drop-down list box allows you to select an individual object for 
editing.  If you do line drawings, each line, box, or circle gets an object number, 
which appears near the object. Whenever you update your image, this number is 
refreshed. Select the object you want to modify in this list box.

[Width]—This box controls the width of line drawing elements. Widths range 
from 1 to 24 pixels on the screen, which translates roughly to point 
measurements on the printer. If you change the current setting, it will affect the 
current object, if present, or the next object you draw.

[Draw]—This check box enables line drawing. Click it before attempting to create



an object. Rockford! will automatically select the next available object number.

[Line], [Box], [Circle]—These options determine the type of object you want to 
draw.

Draw [Black] or [White] Options—These options control the color of the object 
you are going to draw, or change the color of an existing object. Black is the 
default color.

DRAWING AN OBJECT
To draw an object in the WYSIWYG screen, first select the type of object ([Line], 
[Box], [Circle]), then set the width for the lines used to draw the object. Next 
click on the [Draw] checkbox. Move the mouse pointer inside the WYSIWYG 
display. While holding the left button down, drag the mouse pointer to a new 
location. A rubber-band image of your object will appear as you draw. Draw 
slowly for best results. When the object is approximately the right size, release 
the left mouse button to place your object on the screen. A number will appear 
next to the object to identify it. You can move or size any object later.

NOTE: Rockford! does not check to make sure your object is within the 
boundaries of the card. That's your responsibility. Objects extending past the 
card's edges WILL print outside the card's boundaries.

[Move], [Size] Options—These two options determine whether the scroll bars 
(see below) move or size the current object.

[Scroll Bars]—Horizontal and vertical scroll bars control positioning of graphical 
elements. Depending on which of the option buttons above is selected, you can 
move or scale all graphical objects in .005 inch increments.

MOVING AN OBJECT 
Start by selecting the object in the [Object] list box. Next, click on the [Move] 
option button. To move the object in .005" increments, click on the [Up], [Down], 
[Left], or [Right] arrows on the appropriate scroll bar. To move the object in .05" 
increments, click the scroll bar regions between the arrows and the position 
button on the scroll bar. To move the object in larger increments, click and drag 
the position button on either scroll bar.

SCALING A LINE DRAWING OBJECT
First, select the object you want to resize, then click the [Size] option button. 
Then use the scroll bars as described above to alter the size of the object. 

Erasing and Restoring Line Drawing Objects
[Erase Selected]—This button erases the current object, as identified in the 
[Object] list box. This erasure is temporary. 



[Restore]—This button restores objects deleted with the [Erase Selected] 
button. Objects remain in memory unless removed by the [Clear] or [Draw] 
buttons or until a new file is loaded.

[Erase All]—This button removes all graphical elements from the screen. As with
the erase selected button, the image remains in memory, and can be restored 
with the Restore button.

MENU COMMANDS

Some button and list functions are duplicated in traditional Windows menus. 
Other, less-commonly used functions are offered only in menus. For duplicated 
instructions, see the information in the section above for the equivalent button 
command. Here's a rundown:

FILE MENU
New Card Design—Clears the current card and sets up for a new design. If a 
card is already on the screen, you'll be prompted to clear it.

Open Card File—Opens an existing .CAR card design file. For simplicity, store 
your cards in the ROCKFORD directory.

Save Current Card—Saves the current card with the current filename. The 
current file will be overwritten without warning. If you're making a different card, 
use the Save As... command.

Save Current Card As...—Allows you to save the current design under a 
different filename.

Insert Graphic File—Lets you select a clip art image for insertion in your design.
Rockford! supports up to two clip art images on each card. Selection of which 
image is automatic.

Print Quick Sample—This command prints a single card, with a border, on plain
paper. Use this command for fast checking of your design as it will appear when 
printed.

Print Card Layout—This command, whether selected here or after pressing the 
Print button, prints your design in its actual size, and as a double-sized image, 
with crop marks. The double-sized image allows the printer to increase the 
resolution of your design to 600 dots per inch, which is perfectly adequate for 
business card printing, especially when using the thermographic printing process.

Print Sheet of Cards—This command prints an entire sheet of actual-sized 
cards. In the horizontal format, you can print 10 cards per sheet. In vertical 
format, you're limited to 9 cards per sheet. In both cases, lines on the page 



indicate the cutlines for the sheet. Any good, sharp paper cutter will produce 
professional-looking cards. NOTE: If you're printing on precut card stock, be sure
to select the correct option in the Layout menu.

Print Four-Up Camera-Ready Layout—This command prints your cards as a 
block of four cards on the page. Many print shops prefer this format. You may 
choose whether or not to include crop marks. Check with your print shop for its 
preference.

Multiple Copies—In most cases, you'll be asked how many copies you want to 
print. If your printer, like most laser printers,  supports internal multiple copies, 
printing goes much faster if you select the number of copies here. If your printer 
does not support this feature, which is common for dot-matrix and inkjet printers, 
you'll see a dialog box. In this case, just print each copy by giving the print 
command again.
Exit—Quits Rockford!, with a confirmation box. Click [Yes] to save the current 
card and exit. Click [No] to exit without saving. Click [Cancel] to return to 
Rockford!.

EDIT MENU
To use this menu, you must first highlight text in the text-editing box by dragging 
the mouse over the text yu want to edit. Then give one of the commands or its 
keyboard shortcut.

Cut—Removes selected text from the editing box, then stores it in the clipboard. 

Copy—Sends a copy of selected text to the Windows Clipboard. 

Paste—Copies text from the Windows Clipboard to the current cursor location. 

Auto-Updating Enabled—This command is normally off. Click it to add a check 
mark and enable updating whenever you change lines in the text editing box.

Edit Current Picture—Starts Windows PaintBrush and loads the picture 
selected with the option buttons for editing. When you exit PaintBrush, you'll 
return to Rockford!. To insert the altered image, delete the current image, then 
use [AddPic] to reload the image from disk.

Edit Layout Sheet Text—Allows you to set or change the customized text that 
appears at the top of the Rockford!  printed layout sheets. 

LAYOUT MENU
Most of this menu duplicates the buttons in the Layout group.

Horizontal—Changes design to the horizontal format.



Vertical—Changes design to a vertical format.

Regular Card Stock—(Default) Check this menu item to print on normal card 
stock, such as Wasau's Exact Vellum Bristol 67 lb. Cut lines will print for easy 
cutting.

Precut Stock (No Gap Between Columns)—Select this option for precut stock 
with no gaps between columns of cards. For the new stock from Paper Direct.

Precut Stock (1-inch Between Columns)—Select this option for precut stock 
with a 1-in. gap between columns of cards. For the old card stock from Paper 
Direct.

Precut Stock (.5-inch Between Columns)—Select this option for precut stock 
with a .5-in. gap between columns of cards. For stock from Viking Office 
Products.

Precut Stock Notes:
Due to variations in printers and inconsistencies in paper alignment, you cannot 
use borders when printing on this material. 

The Vertical card orientation is not available when using pre-scored stock.

Pre-scored cards are attached to the backing sheet with small un-scored areas. 
You can simply tear the cards from the sheet  or use a single-edged razor blade 
or utility knife.

ALWAYS feed pre-scored card stock manually, and open the rear output tray. 
Since alignment is critical for precut stock, and since printers vary slightly in the 
way they print on the page, you may have to use one of the page shifting 
commands in the Layout menu. Experiment with different measurements on 
plain paper, holding the printout up to your stock. Page shifts are stored in the 
card when you save it.

At this time, pre-scored card stock is available from many sources, with more 
appearing regularly. Two options are: Paper Direct, 205 Chubb Ave., Lyndhurst, 
NJ, 07071 (1-800-APAPERS) and Viking Office Products, (1-800-421-1222). 
Both offer catalogs of paper supplies. Precut cards with preprinted colorful art are
also available from Paper Direct.

Margins—Sets margins for card text. Small changes have big effects, so start 
with small margin measurements. The default is .1 inch.

Offset—Changes the offset for card borders from the edges of the card design. 
Doesn't apply to cards printed on precut stock.



Shift Page Horizontally—Shifts the whole card layout to the left or right. This 
command lets you enter an amount, in inches, to shift the whole page to the left 
or right. Positive numbers move the page to the right; negative numbers move it 
to the left. Use this command on pre-scored stock to set up a perfect alignment 
for your printer. Small numbers, like .05, are usually all you'll need. Be sure to 
make a test printout when using this command.

Shift Page Vertically—Use this command to shift the card layout up and down. 
Positive numbers shift the page down; negative numbers shift the page up.

Special note for HP DeskJet Users: Use the Shift Page Vertically command to
shift your page up .25" if you're having trouble with the last row of cards printing 
on the next page. 

FONTS MENU
Rebuild Font List—This command updates your Rockford! font list. 

Make Current Font Default—This command sets all the lines of a card design to
the font currently shown in the font selection list box. Lines already having 
another font name will not change. This command also sets the font for printing 
the descriptive lines on layout sheets.

INSERT FORMATTING CODES MENU
The commands in this menu insert special codes in your document which allow 
you to alter the appearance of just part of a line. Whenever possible, use the 
whole line formatting tools instead.
Normal—Inserts <N> in the line. This code returns the line to normal text.

Bold—Inserts <B> in the line, boldfacing the following text.

Ital—Inserts <I> in the line, italicizing the followin text.

Underline—Inserts <U> in the line, underlining the following text.

Superscript—Inserts <S> in the line, superscripting the following text.

Subscript—Inserts <R> in the line, subscripting the following text.

Bullet—Inserts a standard bullet character at the cursor position. Try using the 
Custom Alignment option to align bulleted lines.

NOTE: You cannot use inserted codes, other than the bullet, in lines which have 
their alignment set to Centered, Right-Aligned, or Split at Tilde. This would cause 
misalignments, so the options are greyed-out if you attempt to do this.

HELP MENU



Help with Rockford! <F1>—This command opens a new window. On the left is 
an index of topics. To get help on a topic, just click on the topic's name. You can 
scroll through the list or type the first letter of your topic. Once the program finds 
the topic, the index name will appear highlighted at the top of the screen to the 
right, with the help information below. In some cases, a topic will have more than 
one entry. 

About Rockford!—Displays information about Rockford!, including the current 
version number and support information.

OsoSoft Program Information—OsoSoft offers several other programs which 
may interest you. This command displays a window that lets you learn about 
these other programs and lets you order OsoSoft products. To view information 
on a program, click the [Info] button next to that program's name. To order, enter 
the quantity desired for each product. Then fill out your name and address 
information and mark the appropriate disk size box with an X. Click the [Print] 
button to print the form or the [Cancel] button to return to Rockford!.

TUTORIAL SECTION
In this section of the manual, you'll go through the process of creating a business
card, using all the features of the program. Just follow the steps below.

1. Select a format—either horizontal or vertical—for your card, then select one of 
the regular or precut card stock options.. 
2. If the current font displayed under the Font box is not the one you want to use 
for most of the text in the card, choose another font in the Font list.
3. Now enter text for your card in the text editing box. Press <Enter> after each 
line. Subsequent lines will be in the same format and font used in the previous 
line. Insert a blank line anywhere you want vertical spacing. You can alter the font
size of this line to adjust the spacing.
4. To change fonts or other attributes for a line of text, click inside that line of text 
in the editing box. Then, using the command buttons and lists on the right of the 
screen, select a font, size, alignment, and any character formatting you want on 
that line. The [Dupe Previous] button duplicates the formatting of the preceding 
line.
5. If you need split lines with text on both sides of the card, move the cursor to 
the line to be changed, then insert a tilde character (~) where you want the line to
split, andtype the right side of the line. Of course, you can do this when you first 
enter the text for the line as well. To split the line, select Split Line at Tilde in the 
[Alignment] list box. 
6. Adjust the position of characters on your card by inserting spaces at the 
beginning or end of text. Click the [Update] button to view your changes. If you 
use reversed text, spaces will extend the size of the black area. Use the Custom 
Alignment option for precise positioning of lines.
7. Once all your text is in place, you may want to add lines, circles, or boxes, 
using the tools in the Graphics Tools group of commands. 



LINE, BOX and CIRCLE HINTS: Don't forget that you can draw in white as well 
as black. You can erase part of a line or other object by drawing over it in white. 

To add a clip art image to your card, click the [AddArt] button, or use the "Insert 
Graphic File" command in the File menu. Select your graphic from the file list in 
the dialog box, then click [Open] to place it in the upper left-hand corner of the 
card. To add a second image, repeat the same commands. You can use any of 
the tools described earlier to position and size your image. 

If you'd like a border around your card, select one in the [Borders] list box at the 
right of the screen. NOTE: occasionally, thick border lines will appear broken. 
Don't worry. This will correct itself when you update the screen. NOTE: Borders 
are not available when you print on pre-scored card stock.

If you want your border to be farther from the edges of the card, use the [Offset] 
button or the Offset command in the Layout menu. Enter a new measurement, 
but keep in mind that .1 inch moves the border quite a bit. 

Similarly, you can use the [Margins] button or command to move the text in from
the border or card edges. 

NOTE: Due to differences in resolution between screen images and printed 
output, you may notice minor differences in your card. Check your printout with 
the Print Quick Sample command, then make changes in your design to 
produce the results you want.

EDITING YOUR DESIGNS

Editing Text
The easiest way to replace existing text with new text is to highlight existing text 
by dragging over it with the mouse, one line at a time. Once the text is 
highlighted, just type your new text, which will automatically replace the 
highlighted text.

Controlling Line Spacing
To make fine changes in the spacing between lines of text, make sure there's at 
least one blank line between the lines you want to change. Then, position the 
cursor on a blank line and change the font size for that line. When you update the
display, you'll see the changes on your screen. You can make changes in 1-point 
(1/72") intervals. If you need a font size smaller or large than those offered in the 
font size list, simply type it in the display area of the list. Rockford! does not 
accept fractional font sizes.

Placing Text Beside Clip Art
You'll often want to position text next to or around clip art images. To do this, use 



the [Alignment] options. For example, to position text to the right of an image, 
choose the Right Aligned alignment option, then add spaces after the text to 
move it to the position you want. Similarly, use the Left Aligned option to position
text to the left of an image. This time, however, place your spaces to the left of 
the text. To wrap text on both sides of an image, insert a tilde (~) where you want 
the text to break, then choose the Split at Tilde alignment option. Once again, 
pad the text with spaces to achieve the position you need. Don't forget the 
Custom Alignment option for even more precise positioning of lines.

Working with Split Lines
Rockford!'s ability to split lines is very powerful, letting you position blocks of text 
on both sides of the card. Normally, the left half of the line is flush with the left 
margin, while the right half is right-aligned. Often, however, you'll want to center 
blocks of text or manipulate the alignment in other ways. As described above, 
use spaces to pad the text until it's aligned just the way you want. 

Printing Samples
When working with complex card designs, it's a good idea to print occasional 
samples of your design for checking. After printing a sample, you can make 
changes to correct slight misalignments. For speed, use the Print Quick Sample 
command.

ROCKFORD! TIPS 

Printing
1. Printing takes time. Rockford! and Windows have to compose graphical pages 
before a page emerges. You'll need a little patience.
2. If you're printing sheets of cards for instant use, you'll get the best results by 
printing a sheet on good quality card stock. Typically, 67-lb. stock is the heaviest 
that will feed correctly. Use the multiple copy feature in the Print routine to specify
more than one copy. Since you'll want to manually feed the paper, you should 
always set your printer to manual feed in the Windows Printer Setup screen 
BEFORE starting Rockford!
3. For maximum quality when printing Rockford! card designs, be sure your laser 
printer has a good toner cartridge. If you can set print density, choose a medium 
or dense setting to achieve dark blacks for reproduction. If you're sending your 
card to a print shop as camera-ready copy, select a high-quality paper for 
printing. 
4. Rockford! can handle color clip art images, but the final output will depend on 
how your printer interprets the colors in your clip art. You'll get the best results by 
far if you choose black and white line drawings, rather than color or gray-scale 
images.

Creating Multi-Color Cards
You can use Rockford! to produce multi-colored cards. Simply design a complete 
card, with graphics and all text elements. Then delete information that will not 



print in a color and print a layout sheet showing just the material for one color. 
Print a sheet for each color to be used on your card. Rockford! prints accurate 
registration marks on its layout sheets for easy alignment by your print shop.

Working With Clip Art Images
Rockford! accepts both .BMP and .PCX graphics files. Graphics programs, such 
as Windows Paintbrush, supplied with Windows 3.x, can create these files. You 
can convert other file types, using any of a number of format conversion 
programs, such as HIJAAK, Publisher's PaintBrush, and others. 

The size of your image is important. Art for business cards is quite small, almost 
never exceeding 1" in any dimension. While Rockford! can handle much larger 
images, it's usually better to scale large images in a program specifically 
designed to do that. Windows Paintbrush can handle preliminary scaling quite 
well. If you have a scanner, you can create your own clip art in minutes. Simply 
scan the image, then use your scanner software to produce a .BMP or .PCX file 
approximately 300 pixels in each dimension. Naturally, tall narrow images will 
use other dimensions, but you get the idea. 

You can also create clip art images with any paint program that can 
produce .BMP or .PCX files. Creating custom logos isn't difficult at all. Also, a 
number of clip art libraries are available, both commercially and as shareware. 
Most often, however, these images will need conversion to a supported format. 
You'll also find interesting clip art files on the OsoSoft BBS.

Clip Art Tips
1. Very thin lines often don't print well, and don't reproduce well in some printing 
processes, such as thermography.
2. Large black areas may present problems for your laser printer, and sometimes
don't reproduce as completely black.
3. Reducing a large image to business card logo size often results in loss of 
detail.
4. Increasing the size of tiny images such as Windows .ICO icon files usually 
results in jagged lines on your printout.

Lines, Boxes, and Circles
You cannot draw a graphical element that extends into a clip art image. The line 
will end at the edge of the image. You can, however, overwrite text with a line 
graphic. Let the WYSIWYG display be your guide. Be careful not to let lines, 
boxes, or circles extend past the card's borders. Always check the WYSIWYG 
display for conflicts.

Use the [Update] button to see the results of your changes. As you draw and 
move lines, text may not appear if it has been overwritten. Update to see the 
actual image.



Use the [Draw White] option to create special effects. Combining thick lines with 
intersecting white lines can create interesting effects. You can create quite 
complex drawings using the line drawing tools alone, including simple logos.
You can also draw boxes or circles around existing text on your design. It's best 
to first create the text, then follow up with lines, boxes, and circles. Use the 
positioning scroll bars for precise sizing and placement.

TIPS FOR INSTANT BUSINESS CARDS
Since Rockford! can produce sheets of business cards ready for cutting or on 
pre-scored stock, you can use it to create small batches of cards for any 
purpose. Many professional users offer their clients a set of 50-100 cards to get 
them by until their printed or thermographed cards are ready. Individual users 
can use this feature to produce their entire set of cards, avoiding the print shop 
altogether. The tips below will help you get the best results:

1. Use the darkest setting available for your printer.
2. Select a good quality card stock paper, but make sure your printer can handle 
this material. Not all laser printers can cope with heavy paper. For Hewlett-
Packard LaserJets, a 67 lb. paper works just fine. Try Wasau's Exact Vellum 
Bristol. Some printers can handle 80 lb. stock as well.
3. Select the feed option for your printer that sends the paper on the straightest 
path possible through the printer. Usually this means using the rear output tray.
4. Printing takes time. You'll get things done most quickly if you print a sheet of 
cards on regular paper, then copy that sheet on card stock with a high-quality 
copier.
5. Don't settle just for white card stock. If you're an individual user, your local 
copy center can supply this material in several patterns and colors. Using a 
colored or patterned paper will make your card stand out.

DESIGNING EFFECTIVE BUSINESS CARDS
Rockford! doesn't design your business card...You Do! With Rockford!, your 
options are almost unlimited, and you can quite easily produce either an 
excellent card which will create a powerful impact on those who receive it. On the
other hand, you can just as quickly produce an ugly, ineffective card.

The best way to get ideas for business card designs is to study cards others use.
Go through your own collection of business cards or visit a copy center or print 
shop and look at their samples. Which cards jump out at you? Which cards 
present an effective appearance? Which ones do you think are loud, garish, or 
inappropriate? By looking at many card designs, you'll soon develop an eye for 
good design. Still, there are a few basic principles to think about:

1. Make the card fit your profession. Doctors, lawyers, and other professionals 
usually use conservative card designs with few embellishments. On the other 
hand, if you're a gardener or a musician, you may choose a bright, lively card 
design which grabs the recipient's attention immediately and makes him or her 



remember your name.
2. Don't overdo the use of fonts. While it's amazingly easy to include multiple 
fonts using Windows, Rockford! and Adobe Type Manager, try to resist the 
temptation. Typically, your best bet is to choose one attractive font for your name,
company name, or other main lines, then use a simpler font, like Helvetica, for 
details such as addresses and telephone numbers.
3. Avoid over-using reversed text. White on black text shouts at the reader!
4. Similarly, watch your use of graphics. A garish or highly ornamental graphic is 
usually not the most effective tool in card design. Instead, select a company logo 
or a simple line drawing to catch the reader's eye without shocking him or her. 
Most companies have discovered that a highly memorable iconic logo has far 
more impact than an ornate image.
5. The same thing applies to line, boxes, and circles. Keep your design simple for
best results. Don't let a too-bold line object overpower your card. After all, you 
want your customers or clients to remember your name or company name...not a
black line.
6. Finally, if your card needs to display several items in a list, try using 
Rockford!'s [Bullet] feature. It's automatic and effective.
7. If you want to use the custom alignment options, which let you place a line of 
text anywhere on your card, use the option on lines at the bottom of the edit box. 
Since following lines will be influenced by the custom-aligned line, this will avoid 
shifting other lines.
8. If you want a block of text, will all lines having exactly the same left alignment, 
as in a bulleted list or another block of text, put the first line of the block at the 
bottom of the edit box, then align it with the custom alignment tools. If you then 
add lines below this first line, they will have the same left alignment. Experiment.
9. When positioning text with the custom alignment options, if you don't want the 
vertical alignment to change, leave the vertical alignment set to 0, which puts it in
the default position. Should you accidentally shift a line vertically, reset it to 0 to 
restore your original layout.
10. Keep the PIC 1 image on the left side of the card and the PIC 2 image on the 
right, as they first appear. This will make it easy to remember which picture is 
which.
11. You can't overwrite a clip art image with text in this program, so plan your clip 
art and text placement to avoid positioning conflicts.
12. Remember, to move a clip art image, first select it with an option button, then 
click outside the image where you want the upper left corner of the image. This 
works slightly differently than some other Windows programs. If you hold down 
the mouse button after clicking outside the image, you can then drag the image 
to a new location.
13. Use the [Grid] button to temporarily display a grid on your card for 
positioning purposes. The grid spacing is .1 inch, exactly.

Rockford! and its documentation are Copyright, 1991,1992,1993, by George 
Campbell and OsoSoft.


